
Earthwork 4D

Rev. 11-22-2016

• SmartPlan-Android



Limitations of 

Warranty and 

Liability

Trademark 

Credits

AGTEK Software License Agreement

PLEASE READ CAREFULLY.  BY USING THIS PRODUCT, YOU ARE CONSENTING TO BE 

BOUND BY THIS AGREEMENT.

The AGTEK software package, on CD or in electronic form, together with associated 

documentation, is protected under copyright.  The buyer may make copies for the buyer’s 

internal use only.  The buyer agrees not to reverse engineer or otherwise seek to discover 

the source code, or to modify or create derivative works from this software.

AGTEK grants to the buyer a non-exclusive, single license to load and use the AGTEK 

software on one or more computers operated by the buyer, provided that use by the 

buyer shall not be on more than one computer at a time.  The buyer agree not to rent, 

loan or otherwise temporarily transfer this software for use on computers not operated by 

the buyer.

Access key.  The AGTEK software is enabled by means of an access key that must be 

present on the computer when the software is running.  The access key may be a key 

code checked-out from the Internet or a physical device that plugs into a computer port.

AGTEK software includes cryptography that is not user-accessible, specifically designed 

to allow execution of copy-protected software.  Accordingly, this software is controlled 

under ECCN EAR99 of the Export Administration Regulations (NLR, no export license 

required). The buyer agrees to comply with all applicable regulations and prohibitions with 

regard to export or re-export to sanctioned countries or individuals.

Limitations of warranty and liability.  AGTEK software is licensed “as is” and with all 

faults.  AGTEK Development Company, Inc. and its Representatives make no warranties, 

either expressed or implied, with respect to AGTEK software, its quality, performance, 

merchantability, or fitness for any particular use.  In no event will AGTEK Development 

Company, Inc. or its Representatives be liable for direct, indirect, incidental or consequen-

tial damages resulting from any defect in AGTEK software, even if AGTEK Development 

Company, Inc. has been advised of the possibilities of such damages.

Copyright© 2011 AGTEK Development Company, Inc.

Windows XP® , Windows Vista® and Windows® 7 are registered trademarks of 

Microsoft Corp. Google Earth™ is a trademark of Google. AutoCAD®, CAiCE™, DWG™, 

DXF™ are trademarks of Autodesk, Inc. GEOPAK, MicroStation, GPK and DGN are trade-

marks of Bentley Systems, Inc, Leica™
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Welcome to SmartPlan

Instructions for Installing the AGTEK SmartPlan app on your Android Smartphone.

1. Check/Adjust your Smartphone settings.                           

    a. Turn on Location.

        Scroll down from top or select  

        Menu>Settings>Location>On

b.  Allow apps from unknown sources.

     Menu>Settings>Security>Unknown 

       Sources. 

     Note: It is recommended you disable this  

     option after installation is                             

     complete.

2. Install and use SmartPlan from an e-mail on your smartphone. These steps may vary    

 with different phone O/S versions.

   a. Go to your E-mail or G-mail on your

       phone.

b. Locate the e-mail with the subject line 

Your AGTEK SmartPlan App is Ready!
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   c. Go to step 3 and click the link to 

       download SmartPlan. You may also     

       download SmartPlan from our website at  

       www.agtek.com.

  d. Pull down the status bar from the top and

      locate the download. Select the 

      SmartPlan#_##.apk fi le.

  e. Select Install at the bottom of the screen.

      
  f. When complete, the App Installed

      message will display.  Select Open
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  g. Enter your License Key login information.

      Login:  E-mail address  Password: User 

      defi ned.  Select Login

  h. Select the SmartPlan key from the list of

     available keys

  i. Select AGTEK Access.  Select the desired 

     fi le from the list
  j. To exit SmartPlan, select Back, then

      Release

Back
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  k. To restart SmartPlan, select Apps then

     SmartPlan
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  SmartPlan Geo-Referencing Files

Before using SmartPlan on your job site, you must first geo-reference your job file by 

adding two benchmarks with approximate latitude and longitude information in Sitework 

4D. You may use Google Earth® to locate these points.  This procedure is the same for 

files containing plan sheets only for a pre-bid walk-thru, or a complete takeoff to be 

used for job planning and project management.

Enter   Benchmarks and Locate  Lat/Long information

To locate benchmark coordinates, and assign those coordinates in Sitework 4D, it is 

best to have both Sitework 4D and Google Earth® open simultaneously. 

1. Locate your job site on Google Earth.

2. Identify some existing features that can be found on the plan sheets.  Existing build-

ings, catch basins, or street intersections are good examples.
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5. Locate the two common features found on Google Earth.

3. Open the job file in Earthwork 4D.

4. Import the plan sheet containing the existing features located on Google Earth. 

6. Minimize Earthwork 4D and return to Google Earth.
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9.  Keep the name Line Measure and click OK.

10. Right click on Line Measure under Temporary Places and select Save Place As. 

7. In Google Earth, select the Show Ruler icon, or select the Tools menu and select 

Ruler.

8.  Draw a line connecting the two points. Click the Save button.

11. Save the file to the same file folder containing the Earthwork 4D job file. 
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12.  In Earthwork 4D, right click and select Import File.

13.  Select the Line Measure.KMZ file and click Import.

14.  The Benchmarks will be inserted, however they will not be in the correct location.

15.  Change the layer to Benchmarks.

16.  Select one of the benchmarks. Position the tip of the arrow on the corresponding      

  location on the plan sheet and press the F7 key to move the benchmark to the new  

  location.

13.  Repeat this process for the second benchmark.

14.  The KMZ file may now be exported. 
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Save   KMZ File

SmartPlan will read a KMZ file containing the plan sheet images, plan view data, color 

cut/fill map and volume reports. To export the KMZ file, select the Plan View mode icon 

on the toolbar.

1. Select File>Export KMZ File. The Save As dialog box displays.

2. Enter a name for the KMZ file and click Save.

3. The KMZ File Export dialog will display.

4. Select the desired layers to be saved to the KMZ file. 

5. Check the desired additional options, such as the Volume Report or Image Export.

6.  Check Optimize for Mobile when exporting the file to be used with SmartPlan.

7. Check Yes to Upload the file to AGTEK Access for use with SmartPlan. Click Export.
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7. The Choose Access Folder dialog will display. 

8. Select the desired Project folder. If no projects exist click New Project. Enter a name 

for the new project and click OK.

9.  The file will be uploaded to AGTEK Access. The KMZ file will open in Google Earth.

It is recommended you view the KMZ file on Google Earth to verify the accuracy of 

the alignment to the job site.

10. If the KMZ file is properly aligned, you are now ready to use SmartPlan in the field on 

the actual job site.
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5. If the file contains no takeoff data the Reference and Difference surfaces will show 

None.

6. Select the desired project folder.  If no project folder exists, create a new project.

7. Check the boxes to Include Images and Upload to Access. Click OK.

8. The file will be uploaded to the project folder for use with SmartPlan.

2. Click the Save as Type pulldown and select AGTEK Mobile Files (*.adf).

3. Enter a name for the ADF file and click Save.

4. The ADF Save Options dialog will display.

Save   ADF File

SmartPlan will read an ADF file containing the plan sheet images. It is recommended to 

use the ADF file when using plan sheets only for a higher resolution of the images.

1. In Sitework 4D, select the File>Save As.  The Save As dialog box displays.
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  SmartPlan - Basics

SmartPlan geo-references your plan sheets, cut/fill maps, paving areas, pipe runs and 

takeoff quantities using the GPS positioning capability built into your IPhone or IPad. 

Geo-reference the file using the procedure described in the previous section.

1. Before launching SmartPlan, make sure the GPS feature is enabled on your phone. 

This procedure will vary with different phone versions.

2. To launch SmartPlan, locate the SmartPlan icon in your Apps. You may move the 

icon to your Home screen if desired.

3. Enter your Login and Password information. Check the box to Remember password 

and select Login.

4. Select any available SmartPlan Key.

5. If the file has not been saved locally to the phone, select AGTEK Access. 

6. Locate the project folder and select the desired KMZ file. The file will open and 

you will automatically be geo-referenced to the job site. When opening the file for 

the first time, the default view will depend on the contents of the file. If only plans 

sheets were saved, they will display. If the earthwork takeoff was complete, the 

cut/fill color map, report regions and sectional areas may be displayed.
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7. When the GPS signal is engaged, your current position will be locked to the center of 

the screen. To pan the data, tap the compass in the lower right corner to disengage 

the GPS signal. The cross-hairs inside the compass will turn off.

8. You may now pan the data by sliding your finger across the screen.

9. The length displayed at the bottom represents the distance between the last two en-

tered points. The distance displayed is the distance from your current position to the 

last entered point.

10. Tap the compass again to engage the GPS signal. 

     Use the “pinch 

to zoom” (Slide 

your thumb and 

index finger 

apart or together 

on the screen 

making a pinch-

ing motion) to 

zoom in and out 

on the data.

Home

Zoom Out

Zoom In

Zoom Toggle
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2. All data saved in the file will be listed at the bottom of the screen. Visibility is con-

trolled by a checkbox.

3.  To make lines unselectable when tapping the screen, tap and hold on the layer name 

and uncheck selectable. This allows you to choose which layers you wish to select 

on the screen.

  SmartPlan - Layer Controls

When using a KMZ file, all data saved in the file is stored in separate layers. You may 

turn layers on and off by using the layer controls.

1. To change the displayed data, select the Layers icon located at the top of the 

screen. 

Layers
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4. To view the cut/fill volumes, check the box beside Report Regions. You may want to 

uncheck Cut/Fill Color to view the Report Regions more clearly.

5. Tap the Plus sign beside Report Regions to view all the regions. 

6. Tap and hold on the region name to display the volumes. You may also tap the Info 

icon at the top right corner of the screen. 

7. Tap OK to close the volume window.

8. You may also select the report region from the plan view. When the region is select-

ed, the region name will display in the upper right corner.

9. Tap the Info icon in the upper right corner to display the volumes.

10. Sectional volumes may be displayed using the same procedure.

Info
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11. To display the plan sheets, check the box to the right of Plan Sheets. You may dis-

play all the sheets, or you may select the desired sheets. 

12. You will now be walking on the plan sheets.

13. To exit the layer controls, tap the Layers icon.
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  SmartPlan - Measure Mode

Measurements may be made using either the plan sheets or the job data.

1. To enter Measure Mode, tap the Menu and select Measure.

2.  Tap the screen to enter the points.  The length and area will be displayed at the bot-

tom of the screen.  The length is the accumulated length up to the last entered point. 

The area is the shaded area.  To get the total length of the perimeter, you must enter 

a point back on the starting point.  If you make a mistake, tap the Backspace button.

Snap New Measure

Backspace



SmartPlan Tutorial

3-7

3.  Multiple measure areas may be entered.  To enter a new measure, tap the            

New Measure icon. 

4.  To cycle through the entered measures, tap the arrow in the lower right corner of the 

screen. The length and area of the different areas will display.  

5.  To exit Meaure Mode, tap the Menu and select Exit Measure.

New Measure 

Toggle Measures
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  SmartPlan - Photos,Tracks and Notes

As you walk or drive the site, you may use the camera feature to record geo-referenced 

time stamped photos to document the site, as well as record your tracks to mark areas 

of interest, such as obstructions, spoil piles or haul paths. Notes may be added to docu-

ment the site.

1. To take a photo, click the Camera icon on the right side of the screen. 

2. Record the desired photo. Camera options will vary from one device to another, so  

you must become familiar with your specific camera functions.

Track Camera

Notes
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5. To record your path to mark areas of interest or haul paths, tap the Track icon on the 

left side of the screen.  The icon will turn green to indicate tracking is on. 

3. To label the photo, tap and hold on the camera icon located at the position the photo 

was taken.

4. Enter the label and tap OK.

6. Walk around the area as your path is recorded.  
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11. Entered the desired information and tap OK.

12. All photos, tracks and notes must be saved and uploaded to AGTEK Acces to be 

downloaded and reviewed back at the office. Tap the Menu and tap Save.

7. When the path is complete, tap the Track icon to turn off tracking.  

8. To label the tracks, tap and hold on the tracks.

9. Enter the label and tap OK.

10. To add notes, first tap the screen where you want the note to be placed.  Tap the 

Notes icon on the right side of the screen.

13. The default name witl be time stamped with the current date and time. You may 

enter a name if desired and tap Save.
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14. User added data, such as photos, tracks, notes or meassures may be deleted from 

the file.  Tap the Layers icon. 

15. Locate the desired item to be deleted and drag the item name to the left and tap 

Delete.

16. To exit SmartPlan, tap the Back button on the phone or tablet.

17. Tap Release in the bottom right corner of the screen. You must have an internet con-

nection to release the key. 

Back
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5. Select the desired file and click Download.  

6. Select the destination folder and click Save.

  SmartPlan - Download Photos, Tracks and Notes

If photos, tracks or notes were uploaded during the job site session, they may be down-

loaded to the office computer using AGTEK Access. AGTEK Access must be installed to 

use this option.

1. Launch AGTEK Access from your office computer.

2. Open the Projects folder and locate the desired project.

3. Open the desired project folder. 

4. Open the Tracks folder to locate the KMZ file containing the tracks and photos. The 

individual photos will also be stored in the Photos folder.
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7. The KMZ file may be opened in Google Earth to view the recorded photos,tracks, 

notes and measures.


